Treasure Chest Tutorial
Created by TheV Man — Sept. 05 2005

This tutorial will show you how to create achest in 3D Studio Max 7, skinit, and get
it into a WarCraft 3 map.

Tools Required:

- 3D Studio Max 7
War3 File Converter
WarCraft 3 Viewer
WarCraft 3TFT

1. InMax, Start by creating a box using the Standard Primitives option and clicking
on‘Box’
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2. Click to start the box and create a base rectangle:




Then click again to add some height to it...

At this point it doesn't matter what the box looks like because we' Il be changing
itby...

3. ...looking to the right of your perspective view you should see the  Parameters
menul.
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This has the Length, Width and Height properties of your newly created box.
After alittle experimentation | came up with the following values:

Length: 30.0

Width: 20.0

Height: 15.0



4. After putting those values in you should see aroughly rectangular box - our base.

5. Sowe have our base — but how could it hold anything? We need to make a hole!
To do thiswe'll right click on the box and choose ‘ Editable Mesh’ from the menu
(whichin Max is caled the Quad Menu).



6. You'll notice that the side menu has changed again to ook like:

This menu will allow you to do afew different things like:
- Select by Vertex, Edge, Face, Polygon, or Element — each having it's
uses and advantages
- Perform advanced operations like Cut, Weld, and Attach
- Lots of other things | won'’t be covering

7. a Click on the Polygon selection option.



b. And then click on the top of the box, which will turn red.

c. Press‘'Delete’ to remove the selected polygon!

8. Ok, so now we have a hole. But wait, it looks like the back of the box ismissing!
Thisis caused by ‘Backface Culling’ — basically not drawing a surface unless
you're looking at it the right way. We, however, want to see the inside and outside
of the box from all angles. I'll explain why later.

So we'll fix it by right clicking on the box and selecting ‘ Properties'.



0.

10.

11.

Now we can see that under ‘ Display Properties’ Backface Cull is checked —
uncheck it and click Ok.
Marvel at the wonders of the box!

Now that we' re pretty much done with the box for now, we should also rename it
towhat it actually is, the base.

So, with the box selected click in the name box where it says ‘Box01’ and erase
that. Typein ChestBase.

Also don't forget to turn off the Polygon Selection mode by clicking on the
polygon icon again. Forgetting to turn off selection modes when you’ re done with
them can cause much suffering.

Now we' ve got our base, we have to make alid! Thelid of our chest is going to
be the typical arched style (like the kind pirates hide treasure in). Got it
visualized? Good!

Off to the side of the chest we have already, create a Cylinder by clicking on the
Create tab (one with the arrow icon) and clicking on *Cylinder’. Create a cylinder
the same way we did the box back in steps 1 and 2 — the values don’t matter right
this second.



12. So we've got our cylinder, but depending on what viewport you used, it’s
probably looking something like this:

(Newbies love the perspective viewport!)

13. Now we need to rotate the cylinder so we can useit asthe lid —well, half of it
anyway.
With the Cylinder still selected, click on the ‘ Select and Rotate’ icon on the top
toolbar.

14. Now we' re going to use a viewport other than Perspective (* Gasp!*)
In the Left viewport |eft click and drag the mouse to the left. Y ou should see the
cylinder lean down to the right. Keep going until the cylinder islaying ‘flat’ like
the box.
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Ok, looks pretty good right? Wrong! It has WAY too many pieces! WarCraft 3 is
king of low poly art and we' re not about to change that. Again we'll be editing the
properties of the cylinder like we did to the box beforeit.

Change the Height to 30, Radiusto 10, Height Segmentsto 1, and the Sidesto 8.
Why those values? Well if it isn’t apparent form looking at our changes, it has cut
down on the number of polys while retaining the basic shape we want. Plus we' ve
resized the cylinder to the same length as the box (remember kids the cylinder’s
label still says Height, but since it’son it’ s side we have to adjust the height to
make it long enough to sit on top of the base).

Now that we' ve made those changes we need to get rid of the bottom half of the
cylinder! How are we going to do that? Editable Mesh to the rescuel

Just like before, right click on the cylinder and choose ‘ Convert To > Editable
Mesh'.

Now click on the *Vertex Selection’ and in the Front viewport (or
whichever gives you aclear side view of the cylinder, look at it’send), drag a
selection box around the bottom half of the cylinder — but not around the center
verts! | illustrate:



Notice that the selected verts will turn red, to show that they’ ve been selected.

Press Delete and the offending verts find anew home in oblivion — leaving you
with this:

And again we'll turn off Backface Cull by right clicking and going into Properties
on the Cylinder. Uncheck the box and click Ok. Verify by panning down under
the cylinder and make sure you can’t see through it. Good? Good.

17. Now lets put the lid on our chest! Using the different viewports and the Move tool

move it into place. Thiswill be easiest if you turn off the Vertex Selection mode.
It should look like this:



18. Hey gredt, it'sachest! Guess we're all ready to toss a texture on this thing and put
itin War3 right? WRONG! If you look at any of the objects in WarCraft, they’re
never perfect, they always have lots of character. Lets add the some character to
the chest by using the * Select and Uniform Scale’ tool!

Alright, we'll start by adding a little taper to the bottom of the chest to give alittle
more of a perspective look to it.

Click to highlight the box and turn on Vertex Selection mode.

In the Front viewport (or any that fives you a clear view of the bottom of the box
— Left also works) drag a selection box around the bottom two verts on the box
like so:



With those verts selected grab the Select and Uniform Scale tool if you haven't
yet, and |eft click on one of the vertices. Hold the left mouse button and drag
downward to pull the bottom of the box inward (up takes it outward). Only pull it
inalittle—we still want it to be believable as a chest!

Ok that looks about right. If you look at it in Perspective it should look something
likethis:



Lookin' good! But what about that lid? It's alittle boring isn’t it? Lets add a dlight
taper to it too. Something like...

Nice. Asyou can seel did thisin theleft viewport and only tapered the top 2 sets
of verts. By now you should be comfortable doing this.

Don’'t worry that the top seems alittle square, it’ | be ok (honestly | hadn’t noticed
until writing this tutorial and doing all these steps for a 2™ time). If it really does
bother you then go ahead and scale the top-most set of vertsin to keep the angle
going.

Now rename CylinderO1 to ‘ ChestLid'.
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And that’ s the modeling part of the chest done! What' s |eft you say? The
skinning!

Ok, lets start off by opening WarCraft 3 Viewer and extracting the texture for
‘DungeonDoodadQ’ . Convert it as a bitmap and remember that it’s path is
Textures\DungeonDoodad0.blp —we' Il need that!

With that extracted and converted to BMP, open the Material Editor.

In the material editor you'll see 6 spheresin the top section —thisiswhere
materials (aka Textures) are displayed. Scroll down to the section that says
‘Maps’ and click on the + to expand it. Check the box next to * Diffuse Color’.

Now click on the ‘None’ button beside Diffuse Color and it will open another
window with alisting of existing materials. Double click on ‘Bitmap’ and this
will open adialogue to browse to our texture.

Find the texture and select it — it should be showing a preview (if not check the
Preview option). Looks like a bunch of junk right? Right! That’s what we're after.
Click Open and you' |l see the texture appear on the first sphere (unless you
selected a different one).

Now we'll left click on that sphere and drag the texture to the lower part of the
chest. Let go of the left mouse button and...wait, it just turned grey? Well that’s
because we need to turn on...



...Show Map in Viewport.
And now you should see your texture on your box. Doesn’t ook very good, does
it?

Well that’ s because we need to tell it what part of that texture is going where.

22. The Modifier List *dramatic chord*

It can be found on the ‘Modify’ tab and houses all sorts of things to play havoc
with models. The one we're after is*Unwrap UVW'.
When you click on it, the modifier will be added to the list that, up until now, only
housed * Editable Mesh'.

23. Click on the + beside Unwrap UVW and then on * Select Face’ like so:
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Now we need to select what faces we' re mapping onto. In this case just press
CTRL+A, the shortcut for Select All — since we want the whole box textured.
You'll notice that the box will turn red. Now click on Edit on the Parameters
rollout.

Thiswill bring up the edit window for the UVWSs. Y ou might notice that the
texture seems alittle dark and it’ s also tiled. Lets fix that by clicking on the
Options button (bottom right of the window), uncheck ‘ Tile Bitmap’ and change
the Brightness setting to 1.

Much better.

Y ou should also see a green line bordering the texture —which if you press
CTRL+A again, gets selected and turnsred. You'll see some little red boxes
around the outside. These are points that you can grab onto to move, rotate and
scal e the bounding box —which is determining what is going to show on the
outside of the box!

Go ahead and move it around a bit. With just one box like this we' re doing what’s
called Planar Mapping. Don’t ask anymore about it, the help files can tell you
more than | can. | highly recommend them.

Scale the box down do it covers the box texture in the bottom I eft of the screen.



You'll be able to see the image update in the perspective viewport as you go so
feel free to experiment. If you get in trouble just close the UVW window and
click on ‘Reset UVWS' on the Parametersrollout. Thiswill reset everything back
to the start — something that will probably have to be done fairly often (for me
anyway).

Ok, after you’ ve got everything in place your chest should look something like
this:

Onceit’sin place click on ‘ Select Face’ again to turn off the Selection mode.

26. With the bottom textured, it’s tome to move onto the lid. This can be tricky and
may take awhile.
Start out by opening the material editor and dragging the same texture from slot 1
onto the lid. Make sure that Show Map in Viewport is on so you can seeiit.
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Go into the Modifier list for the lid and ass Unwrap UVW, just like we did for the
base of the chest. Expand the modifier, click Select face and Press CTRL+A to
select al the faces again.

Click *Edit’ to open the UVW dialogue and we're off to the races again.

Change the brightness and stop that infernal tiling again, then lets get down to
business.

If wetry to resize the existing box in the UVW editor we're end up with
something really awful like this:

Not very pretty. So we'll change the type of mapping we' re doing!

Something to note before we get much further: Max can and will lock up during
UVW Editing. SAVE OFTEN.

Alright, go to the Mapping menu and choose * Flatten Mapping' . L eave the default
settings and click Ok.

Now you'll see all the pieces of the lid —two ends and 3 long dats. Start out by
grabbing the slat nearest the bottom left texture (same that we used on the lid) and
scaleit down. Inthe end it’ll look like this:



Notice that on the top and bottom | didn’t include the gold parts — that’ s because
we don’t want the gold breaking up the wood.

Continue to do the same with the other two long, rectangular pieces. It may take
some practice but you'll get it eventually. Asyou go and have each piece sized to
the way you like it you can move it out of the way so you don’'t accidentally grab
onto the wrong box.

Another important item isto experiment! All of these are totally valid depending
on how you want the chest to |ook!

So this is how mine ended up looking:



Which takes care of the lid —well except for the sides. Lets get to those next.

28. Now you should be left with the two sides, look like this:

The one on the left is easy to deal with, so move the other pieces you've got in
place from the previous step out of the way. We're going to grab the left side of
the lid and scale it down, then move it into place the same way that you did with
the others.



That’s not bad, but it’s not great either. How can we make that gold rimming run
all the way around the edge of the lid? By moving the points so the lid in the
UV W editor looks like a square!

There we go. And if you do the same with that other corner....



Move the piece you just did out of the way since we have one last piece to do.

29. For thelast piece you COULD just drag it down and resize it into a box, but keep
in mind that not all your textureswill be THIS easy. There' s arotate tool on the
toolbar (same as the one we used earlier in max). So let’s use it to spin the other
part of the lid around and then move it into place. This should be pretty easy by
now so | won't walk you through it.

With that in place we can safely move all our other pieces back over that part of
the texture to make it look like areal chest!
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Congratulations. Y ou’ ve modeled and skinned the Treasure chest. Bang up job if |
do say so myself. But wait...how do we get it from here to WarCraft 3?

| use ‘DeX’ s exporter script v1.85, which can be found via Google.
So let’ s select al the objects in our scene (you did turn off Face Selection mode
when you finished texturing right?).

Make sure to center the chest in all the viewports—if you don’t you' Il notice that
the selection circle doesn’'t surround your object quite right. It’'s easy to miss so
try to remember.

With all that still selected go into the Utilities Tab in the Right Bar Menu and
click on the Max Script button. If the script doesn’t appear in the dropdown then
click on the Open Script button and choose ‘ DeX’ s script.

Thiswill open a new window with al the code for the script. Click on File >
Evaluate All and another menu will appear. Here you can enter lots of useful
things but all we'reinterested inisModel Name. Put in whatever you like
(TreasureChest is a good choice) and click on Export to File.

Choose where you want to export it to and click Save.

Now close al the windows, and Max as well because we' re done with it.

Browse over to the directory you exported your fileto (it'll bea.MDL file) and
right click onit.

Choose to open it and use notepad (but don’t leave the * Always use this program’
option checked —we don’t need that file association hanging around).

So you should now see all the model datain anicely formatted file. Pretty neat.
To make sure that the texture will show once we put it into War3, we need to find
the Textures section of thefile like so:

Edit it by deleting the ‘ Replaceableid 1, line.

Now, remember that path | told you to remember earlier? Here' s where we need
it. Typeit into the quotation marks after ‘Image’. The edited section should now
look like...
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Savethefile (with File > Save). Overwriting the one we have is fine since we can
always just re-export the model again if need be.

Using the War3 File Converter, convert the MDL to an MDX.

Now lets fire up the World Editor and get our chest in there!
Make a new map — or open one you want the chest in and open the Import

Manager (hotkey is F12) and choose Import File.
Import both your Chest and the Texture (DungeonDoodad0).

. Now thisisthe part that confuses |ots of people when they start out — just

accepting thisWILL get your model in, but it WILL NOT be textured. To fix this,
double click on the texture file and check the * Use Custom Path’ box, then delete
the part that says ‘war3mapimported\’ but leave the texture namel!

Ok so we're aimost there. Now let’s create a custom doodad and make use of our

model. Close the import manager and open the Object Editor

In here go into File > New Custom Doodad.

Name it whatever you like (again Treasure Chest is a sensible choice), and choose
whatever tileset you'rein for the Base Doodad field (I’ m using L ordaeron
Summer). Leave the category as Props (or change it to Propsiif it didn’t
automatically).

Now we have to choose an existing prop to use asamodel (which we'll change in
aminute). Use something sensible like Crates Empty or something. Click Ok!

Now we can see our new Doodad is selected. In the properties (right pane) look
for the field called Art —Model File. Double click it to see...

Change the radio button to ‘ Import’ and click on Ok and then close the Object
Editor.
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At this point we'll save the map (Say Yesto al the dialogues telling you about
custom doodads and start positions) and close World Edit, then reopen it.
Closing and reopening is required whenever you bring in custom models.

Ok, reopen your saved map and go into the Doodads section, then into Props.
Scroll down until you see your Chest and click on it. Now you can freely place it
on the map, or rotate it, or whatever you like.

Thisisasmaller chest. If you want it to be bigger, go back to just before we
exported it and use the Select and Uniform Scale tool to make it larger, then
follow the instructions from there down.

Feel freeto test your map and have peons and peasants marvel at the works you
have wrought. If for some reason the texture is missing then go back afew steps
and see if you missed anything.

Don't stop there though — remember how we turned off Backface Culling for the
box and cylinder? The reason | did this was so that if you choose to open the chest
(rotate the lid asiif it were hinged on the back) you would see the texture on the
inside as well.

Why not put something in the chest? Some gold, or afew skulls—the sky’sthe
limit. Lets see what you can come up with.

Anyway, that’s my two bits.
Good luck and good modding.



